The fast, easy to use, Open-source 3D printer

assembly instructions
Dear customer,

Thank you for purchasing the Ultimaker Original DIY kit and welcome to our community!

This assembly manual will guide you through the build process step by step. During the excitement of the build process you learn more and more. This will help you understand the workings of a 3D printer even better and give you the opportunity to get the most out of your Ultimaker.

Besides this assembly manual there’s also a user manual available online: www.ultimaker.com/pages/support/manuals

Meet other Ultimaker users at our community forum: www.ultimaker.com/forum

Visit YouMagine for fun projects and free printable models: www.youmagine.com

Happy building and printing and we’ll be in touch!

Team Ultimaker

Contact information

We would love to hear from you. We are easy to reach and enjoy answering all your questions. Technical assistance, sales enquiries or general information, we are there for you. Find the information below to contact us.

<table>
<thead>
<tr>
<th>General</th>
<th><a href="mailto:info@ultimaker.com">info@ultimaker.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Support</td>
<td><a href="mailto:support@ultimaker.com">support@ultimaker.com</a></td>
</tr>
<tr>
<td>Sales</td>
<td><a href="mailto:sales@ultimaker.com">sales@ultimaker.com</a></td>
</tr>
<tr>
<td>Marketing/PR</td>
<td><a href="mailto:pr@ultimaker.com">pr@ultimaker.com</a></td>
</tr>
<tr>
<td>Phone</td>
<td>+31 (0)345 712 017</td>
</tr>
</tbody>
</table>

Meet us online at:
Table of contents

1 Introduction
   1.1 Product description
   1.2 Used symbols

2 Technical specifications
   2.1 General product specifications
   2.2 Environmental conditions

3 Precautions and safety instructions

4 Preparation before assembling
   4.1 Engraving
   4.2 Sanding

5 What to expect reading the assembly instructions
   5.1 Structure of the assembly instructions
   5.2 Different sides of the Ultimaker Original

6 Assembling the Ultimaker Original
   6.1 Assembling the frame
      6.1.1. Step 1: Inserting the ball bearings
      6.1.2. Step 2: Mounting the limit switches
      6.1.3. Step 3: Assembling the X and Y motor
      6.1.4. Step 4: Preparing the BOTTOM panel
      6.1.5. Step 5: Assembling the ‘cube’-shaped frame
      6.1.6. Step 6: attaching various parts
   6.2 Assembling the X/Y axes
      6.2.1. Step 1: Assembling the FRONT, BACK, RIGHT, LEFT slider blocks
      6.2.2. Step 2: Attaching the claws
      6.2.3. Step 3: Mounting the caps
      6.2.4. Step 4: Mounting the axes
   6.3 Assembling the extrusion head
      6.3.1. Step 1: Assemble the extrusion head housing
      6.3.2. Step 2: cooling fan assembly
      6.3.3. Step 3: attaching the housing on the XY frame
   6.4 Assembling the Z stage
      6.4.1. Step 1: Assembling the drive nut assembly
6.4.2. Step 3: LEFT and RIGHT arm assembly
6.4.3. Step 2: inserting the adjustable level screws
6.4.4. Step 4: finishing the Z stage assembly
6.4.5. Step 5: Applying tape to the bed.
6.4.6. Step 6: installing the Z stage in the machine
6.4.7. Step 7: greas it up

6.5 Assembling the material feeder
   6.5.1. Step 1: drive mechanism main body assembly
   6.5.2. Step 2: drive bolt assembly
   6.5.3. Step 3: clamp assembly
   6.5.4. Step 4: attaching the feeder to the machine
   6.5.5. Step 5: assemble the filament holder

6.6 Mounting the electronics circuit board
   6.6.1. Step 1: mounting the electronic circuit board
   6.6.2. Step 1: preparing the electronic cooling system
   6.6.3. Step 3: connecting the heater
   6.6.4. Step 4: connecting the print head electronics
   6.6.5. Step 5: connecting the limit switches
   6.6.6. Step 5: connecting the motors
   6.6.7. Step 7: mounting the electronics cooling system
   6.6.8. Step 7: strain relief
   6.6.9. Step 9: checking and aligning the top-Z limit switch

6.7 Assembling and connecting the Ulticontroller
   6.7.1. Step 1: assembling the Ulticontroller
   6.7.2. Step 2: connecting the controller

7 Usage of the Ultimaker Original
   7.1 Using the Ultimaker Original for the first time
      7.1.1. Slicer software

Bijlage I EG verklaring van overeenstemming
1 Introduction

1.1 Product description
The parts of the Ultimaker Original can only be used for assembling the Ultimaker Original. An assembled Ultimaker Original can only be used for 3D printing of products.

Ultimaking LTD cannot be held liable for any damage caused by improper, incorrect or unwise use. Please read this manual completely and make sure you understand it.

1.2 Used symbols
⚠️ Warning! A warning indicates the risk of (serious) damage to the user or the product if the user does not carry out the procedures with care.
⚠️ Caution! A comment makes the user aware of possible problems
ℹ️ Notice: A notice makes the user aware of convenient functions and additional options.
2 Technical specifications

2.1 General product specifications

Product description
Name: Ultimaker Original
Model/type: Revision 4
Year of production: 2014
Dimensions (W x D x H): 357 x 342 x 388mm
Mass: 9 kg

Technical specifications
Power source: 110V or 230 V
Operating system: Windows, MAC and Linux
Speed: Max. head travel speed between 30mm/s - 300mm/s.
Accuracy: Positioning < 0.05mm
Build volume (X,Y,Z): 210 x 210 x 205mm
Technology: FFF (Fused Filament Fabrication)
Ambient Operating Temperature: 15° - 32° C
Storage Temperature: 0° - 32° C

2.2 Environmental conditions

The Ultimaker Original can only be used in a dry environment. The product cannot be used in a humid environment and in an environment with lots of UV light. Usage in other environments can result in unwanted effects on the performance of the product.
### Precautions and safety instructions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️</td>
<td>Only use original accessories from the manufacturer.</td>
</tr>
<tr>
<td>⚠️</td>
<td>The product should only be used for applications as described by the manufacturer. All other applications are unprofessional and considered dangerous. The manufacturer cannot be held liable for damage resulting from errors, unintended or unprofessional use of the device.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Do not install the product outdoors or in any place where it might become wet.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Do not install the product in any place that might be exposed to extreme heat or cold.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Keep the product out of reach of children.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Disconnect the device from all power sources before cleaning it.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Remove the adapter from the power outlet during storms, lightning and whenever the product will not be used for a longer period of time.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Install the product as indicated in this manual. If in doubt, consult a recognized technician and always take account of local installation codes and regulations.</td>
</tr>
<tr>
<td>⚠️</td>
<td>The product should be kept out of direct sunlight.</td>
</tr>
<tr>
<td>⚠️</td>
<td>The product must not be discarded as unsorted municipal waste, it must be disposed of separately.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Find out about the options in your region for disposing of the product after use. Do not throw away electrical appliances or components, but see whether the product (components) can be turned in, recycled or reused.</td>
</tr>
</tbody>
</table>
4 Preparation before assembling

4.1 Engraving
All panels are marked with the side they belong to.
For all the panels except the FRONT panel and the BOTTOM panel, the
ingraving face. The FRONT panel has the “Ultimaker” engraving facing
outward. The BOTTOM panel has the engraving facing downward.

4.2 Sanding
Before starting the assembly, you may want to sand the panels slightly to
remove any burn marks/blemishes from the laser cutting process. You can also
paint or stain your Ultimaker Original. Be aware that paint will not cover the
brown cutting edges very well.

5 What to expect reading the assembly instructions

5.1 Structure of the assembly instructions
Before assembling the Ultimaker Original, separate sub assemblies have to be built.
The description of every sub assembly in this manual will contain:
• An overview of the needed tools;
• An estimation of the needed time to build the sub assembly;
• The steps;

Every step in this manual will be described using the following structure:
• Cautions and warnings (if applicable);
• The needed parts;
• The actions to perform the step.

To make this manual easy to understand, images are used as much as possible.
5.2 Different sides of the Ultimaker Original

In this manual, you will read about FRONT side, BACK side, LEFT side, RIGHT side, TOP side and BOTTOM side. In image 1 these terms are clarified.

*image 1: sides of the Ultimaker Original*
6 Assembling the Ultimaker Original

6.1 ASSEMBLING THE FRAME

WHAT YOU’LL NEED TO BUILD THIS SUB ASSEMBLY.

**Time:**
about 60 to 90 minutes

**Tools:**
- hex key screwdriver (1,5mm)
- hex key wrench (2mm)
- 5.5mm (M3) socket wrench or pliers
6.1.1. **Step 1: Inserting the ball bearings**
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>FRONT panel</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>LEFT panel</td>
<td>1</td>
</tr>
<tr>
<td>C</td>
<td>RIGHT panel</td>
<td>1</td>
</tr>
<tr>
<td>D</td>
<td>BACK panel</td>
<td>1</td>
</tr>
<tr>
<td>E</td>
<td>ball bearings 8mm</td>
<td>8</td>
</tr>
</tbody>
</table>

Every panel needed for this step has two corresponding holes.
To place the ball bearings, perform the following actions:

1. Get a panel.
2. Place the ball bearings.
   Make sure you place the ball bearings as deep as shown in image 3.
3. Repeat action 1 and action 2 for all panels.
6.1.2. Step 2: Mounting the limit switches

⚠️ Warning! Do not strain the tapped thread on the inside of the switch housing by putting a lot of force on the bolts. All limit switches are pre-tapped, you can fasten them directly with M3 bolts, no nuts required here!

⚠️ Caution! Note that all wires of limit switches need to be twisted, see image 4.

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qnty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>FRONT panel</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>LEFT panel</td>
<td>1</td>
</tr>
<tr>
<td>C</td>
<td>BACK panel</td>
<td>1</td>
</tr>
<tr>
<td>D</td>
<td>RED wired limit switches</td>
<td>2</td>
</tr>
<tr>
<td>E</td>
<td>BLUE wired limit switches</td>
<td>2</td>
</tr>
<tr>
<td>F</td>
<td>BLACK wired limit switches</td>
<td>2</td>
</tr>
<tr>
<td>G</td>
<td>bolts M3 x 12mm</td>
<td>8</td>
</tr>
<tr>
<td>H</td>
<td>bolts M3 x 16mm</td>
<td>4</td>
</tr>
<tr>
<td>I</td>
<td>washers</td>
<td>2</td>
</tr>
</tbody>
</table>
The orientation of the limit switches are engraved on the panels, except for the FRONT panel.
The machine has 6 limit switches:
• 2 with BLUE wires
• 2 with RED wires
• 1 with LONG BLACK wires
• 1 with SHORT BLACK wires
To mount the BLUE wired limit switches to the front panel, perform the following actions:

1. Place the BLUE wired limit switches as shown in image 5.
2. Attach each BLUE wired limit switch with two bolts M3x12mm.

To attach the RED wired limit switches on the left panel, perform the following actions:

1. Attach the RED wired limit switches as shown in image 6.
2. Attach each RED wired limit switch with two bolts M3 x 12mm.
To attach the BLACK limit switch with LONG wires, perform the following actions:

1. Attach the BLACK limit switch with LONG wires as shown in image 7. Fine tuning the position will be described in another part of this manual.
2. Attach the BLACK limit switch with LONG wires. Use two bolts M3 x 16mm and two washers.

![image 7: attaching the BLACK wired limit switch with LONG wires]
To attach the BLACK wired limit switch with SHORT wires, perform the following actions:

1. Place the BLACK wired limit switch with SHORT wires as shown in image 8.
   Fine tuning the position will be described in another part of this manual.
2. Attach the BLACK wired limit switch with SHORT wires.
   Use two bolts M3 x 16mm.

6.1.3. **Step 3: Assembling the X and Y motor**

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qnty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>LEFT panel</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>BACK panel</td>
<td>1</td>
</tr>
<tr>
<td>C</td>
<td>motors with long wires and rounded axles</td>
<td>2</td>
</tr>
<tr>
<td>D</td>
<td>black spacers</td>
<td>8</td>
</tr>
<tr>
<td>E</td>
<td>M3 washers</td>
<td>8</td>
</tr>
<tr>
<td>F</td>
<td>short timing belts</td>
<td>2</td>
</tr>
<tr>
<td>G</td>
<td>pulleys with a 5mm internal diameter</td>
<td>2</td>
</tr>
<tr>
<td>H</td>
<td>bolts M3 x 20mm</td>
<td>8</td>
</tr>
</tbody>
</table>
To assemble the Y motor, perform the following actions:

1. Place the pulley (5mm internal diameter) on the Y motor, see image 10. When placing, make sure to keep a distance of 1-2mm between the pulley and the Y motor.
2. Place the timing belt around the pulley, see image 11.
3. Attach the Y motor on the LEFT panel with Y motor engraved on the inside, see image 12.

**Notice:** Do not attach the X motor and Y motor too tight. The X motor and Y motor must be able to move up and down.

**Notice:** Place the X motor and Y motor in position that the wires face down in direction of the text.

4. To assemble the X motor repeat action 1-2.
5. Make sure to attach the X motor on the BACK panel with X motor engraved on the inside.
Step 3: Assembling the X and Y motor

Assembling the frame

**Image 10:** Placing the pulley on the Y motor axis

**Image 11:** Placing the timing belt around the pulley
Step 4: Preparing the BOTTOM panel

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qnty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>BOTTOM panel</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>pieces of Velcro</td>
<td>4</td>
</tr>
<tr>
<td>C</td>
<td>bolts M3 x 10mm</td>
<td>4</td>
</tr>
<tr>
<td>D</td>
<td>motor with short wires and rounded axles</td>
<td>1</td>
</tr>
<tr>
<td>E</td>
<td>coupling</td>
<td>1</td>
</tr>
</tbody>
</table>

image 12: attaching the Y motor on the LEFT panel
Step 4: Preparing the BOTTOM panel

Assembling the frame

To prepare the BOTTOM panel, perform the following actions:

1. Move 4 pieces black Velcro through the 4*2 slots of the BOTTOM panel, see image 14. Make sure the soft side is facing itself after placing.

2. Attach the Z-motor, see image 15. Attach the motor such that the wires face out towards the center of the BOTTOM panel.

3. Attach the coupling on the motor axis. The 5mm opening of the coupling has to face towards the motor.

4. Tighten the screws, see image 16. Make sure there’s a little space between the coupling and the BOTTOM panel.

ℹ️ Use the 1,5 mm hex key as a guide.
Step 4: Preparing the BOTTOM panel

Assembling the frame

image 14: moving black Velcro through the slots

image 15: attaching the motor
6.1.5. **Step 5: Assembling the ‘cube’-shaped frame**

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>panels (TOP, BOTTOM, FRONT, LEFT, BACK and RIGHT)</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>A SHORT cable ducts</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>B LONG cable ducts</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>C blue Scotch tape</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>D bolts M3 x 16mm</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>E hex nuts 3mm</td>
<td>37</td>
<td></td>
</tr>
</tbody>
</table>

*image 16: placing the coupling and tightening the screws*
Step 5: Assembling the ‘cube’-shaped frame

Assembling the frame

23

Warning! Be careful not to put any force on the panels because they are weak in this configuration; however they will become very sturdy once you mount a few more panels.

To assemble to ‘cube’-shaped frame, perform the following actions:

(for action 1-5 see image 18)

1. Place the BACK panel on the table.
   Make sure the markings are facing towards you.
2. Put the TOP panel, with the markings downwards, into the BACK panel.
3. Put the BOTTOM panel into the BACK panel.
   The 3 holes in the top panel must be on the side of the back panel.
4. Put the FRONT panel in the TOP and the BOTTOM panel.
5. Attach the four panels.
   Use thirteen bolts M3 x 16mm and thirteen hex nuts 3mm.
   Notice: loose fixation is highly recommended. You can tighten later.
   Notice: if you attach the hex nuts, it can be helpful to use some tape to keep them in position.
   Notice: make sure no cables get jammed before tightening.
Step 5: Assembling the ‘cube’-shaped frame

Assembling the frame

6. Place a SHORT cable duct on the RIGHT side of the BACK panel.
7. Fold the SHORT cable duct.
8. Tape the folded SHORT cable duct (to keep it folded).
   Notice: make sure the blue Scotch tape can be removed easily.

9. Place a LONG cable duct on the RIGHT side of the FRONT panel.
10. Fold the LONG cable duct.
11. Tape the folded LONG cable duct (to keep it folded).
    Notice: make sure the blue Scotch tape can be removed easily.
12. Place the RIGHT panel.
13. Attach the RIGHT panel.
    Use twelve bolts M3 x 16mm and twelve hex nuts 3mm.
14. Remove the blue Scotch tape.
Step 5: Assembling the ‘cube’-shaped frame

Assembling the frame

25

15. Turn the Ultimaker Original on it’s RIGHT side.
16. Place the second SHORT cable duct on the LEFT side of the BACK panel, fold it and tape it.
17. Place the second LONG cable duct on the LEFT side of the FRONT panel, fold it and tape it.
18. Place the LEFT panel.
19. Attach the LEFT panel.

   Use twelve bolts M3 x 16mm and twelve hex nuts 3mm.
20. Remove the blue Scotch tape.

(for action 15-20 see image 21)
Step 5: Assembling the ‘cube’-shaped frame

Assembling the frame

26

image 21: positioning the other SHORT and LONG cable ducts and attaching the LEFT panel

image 22: complete the frame by checking if all the bolts are tightened
21. Move the wires of the limit switches through the cable ducts.  
   **Notice:** try to guide the endstop cables behind the y motor.  
22. Move the wires of the X- and Y motor through the cable ducts.  
23. Complete the frame, see image 22.  
   Use twelve bolts M3 x 16mm.

Well done, the frame should look like this (see image 23).

---

**6.1.6. Step 6: attaching various parts**

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>wooden part 11A</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>wooden part 3A</td>
<td>2</td>
</tr>
<tr>
<td>C</td>
<td>bolts M3 x 16mm</td>
<td>6</td>
</tr>
<tr>
<td>D</td>
<td>hex nuts 3mm</td>
<td>4</td>
</tr>
<tr>
<td>E</td>
<td>lock nuts M3</td>
<td>2</td>
</tr>
</tbody>
</table>
To attach the various parts, perform the following actions:

1. Attach wooden part 11A, see image 25. **Make sure the lock nuts M3 are attached on the outside.**
   Use two lock nuts M3 and two bolts M3 x 16mm.

2. Attach two wooden parts 3A to the bottom of the machine.
   Use two bolts M3 x 16mm and two lock nuts M3 for each wooden part 3A.

   **Notice:** wooden part 3A is 6mm thick, NOT 4mm.
Step 6: attaching various parts

Assembling the frame

Great work! The frame is now ready! On to the next section.
ASSEMBLING THE X/Y AXES

WHAT YOU’LL NEED TO ASSEMBLE THE X/Y AXES.

**Time:**
about 60 to 90 minutes

**Tools:**
hex keys (2mm)
hex keys (1.5mm)
6.2.1. Step 1: Assembling the FRONT, BACK, RIGHT, LEFT slider blocks

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>wooden part 11A sliderblock parts 6mm 12 x sliderblock part 4mm 8 x</td>
<td>20</td>
</tr>
<tr>
<td>B</td>
<td>linear bearings</td>
<td>4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>FRONT slider block</th>
<th>LEFT slider block</th>
<th>RIGHT slider block</th>
<th>BACK slider block</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong></td>
<td><img src="image" alt="image" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>B</strong></td>
<td><img src="image" alt="image" /></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To assemble the FRONT, RIGHT, LEFT, BACK slider blocks, perform the following actions:

1. Push the bearing through the wooden parts, see image 28. Make sure the bearing sticks out both sides of the FRONT slider block (approx. 1 mm)
2. Do the same for the RIGHT, LEFT, and BACK slider blocks. Make sure the order of the wooden parts are correct.

<table>
<thead>
<tr>
<th>FRONT slider block</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image of FRONT slider block]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LEFT slider block</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image of LEFT slider block]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RIGHT slider block</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image of RIGHT slider block]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BACK slider block</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image of BACK slider block]</td>
</tr>
</tbody>
</table>

image 29: Result assembling FRONT, LEFT, RIGHT and BACK slider blocks

6.2.2. **Step 2: Attaching the claws**

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>FRONT, LEFT, RIGHT, BACK slider blocks</td>
<td>4</td>
</tr>
<tr>
<td>B</td>
<td>bolts M3 x 10mm</td>
<td>8</td>
</tr>
<tr>
<td>C</td>
<td>4mm wooden parts marked C</td>
<td>4</td>
</tr>
<tr>
<td>D</td>
<td>hex nuts 3mm</td>
<td>24</td>
</tr>
<tr>
<td>E</td>
<td>bolts M3 x 30mm</td>
<td>12</td>
</tr>
<tr>
<td>F</td>
<td>wooden parts marked C</td>
<td>4</td>
</tr>
</tbody>
</table>
To attach the claws, perform the following actions:

1. Attach the bolt to the wooden part marked C, see image 31.
   Use one bolt M3 x 10mm and two hex nuts 3mm.
   **Notice:** the last hex nut will barely fit in. This is normal.

2. Place the wooden part marked C in the FRONT slider block.

3. Place three bolts M3 x 30mm, see image 32.

4. Attach the nuts, see image 32.
   **Notice:** do not tighten the nuts too much. The claw must be able to rotate.

5. Repeat action 1-5 three times to attach all wooden parts marked C on all slider blocks.

6. Assemble the 4mm wooden parts, marked C, see image 33.
   Use one bolt M3 x 10mm and one nut.
   **Notice:** this assembled wooden parts, marked C will be used later.
6.2.3. Step 3: Mounting the caps

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>wooden end caps WITHOUT hole</td>
<td>8</td>
</tr>
<tr>
<td>B</td>
<td>wooden caps WITH hole</td>
<td>6</td>
</tr>
<tr>
<td>C</td>
<td>bolts M3 x 16mm</td>
<td>16</td>
</tr>
<tr>
<td>D</td>
<td>hex nuts 3mm</td>
<td>16</td>
</tr>
</tbody>
</table>
The wooden caps have to be attached in four corners of the Ultimaker Original. To help you performing the actions, the following overview is provided, see image 35.
To attach the wooden caps, perform the following actions:

1. Attach the wooden caps in corner A, see image 36.
   The wooden caps WITH hole on the inside, the wooden end caps WITHOUT hole on the outside.
   
   Notice: Use two bolts M3 x 16mm and two hex nuts 3mm at both panels.

2. Attach the wooden caps in corner B, see image 37.
   The wooden caps WITH hole on the inside, the wooden end caps WITHOUT hole on the outside.
   
   Notice: Use ONE bolt M3 x 16mm and ONE hex nut 3mm at the RIGHT panel.
   
   Notice: Use two bolts M3 x 16mm and two hex nuts 3mm at the FRONT panel.
3. Attach the wooden caps in corner C, see image 38. The wooden caps WITH hole on the inside, the wooden end caps WITHOUT hole on the outside. Use ONE wooden end cap WITHOUT hole at the BACK panel.

**Notice:** Use ONE bolt M3 x 16mm and ONE hex nut 3mm at the RIGHT panel.

**Notice:** Use ONE bolt M3 x 16mm and ONE hex nut 3mm at the BACK panel,

![image 38: attaching the wooden caps in corner C](image)

4. Attach the wooden caps in corner D, see image 39. The wooden caps WITH hole on the inside, the wooden end caps WITHOUT hole on the outside. Use ONE a wooden end cap WITHOUT hole at the LEFT panel

**Notice:** Use ONE bolt M3 x 16mm and ONE hex nut 3mm at the BACK panel,

**Notice:** Use two bolt M3 x 16mm and two hex nuts 3mm at the LEFT panel.
6.2.4. Step 4: Mounting the axes

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FRONT, LEFT, RIGHT, BACK slider blocks</td>
<td>4</td>
</tr>
<tr>
<td>A</td>
<td>timing belts</td>
<td>4</td>
</tr>
<tr>
<td>B</td>
<td>axes SHORT</td>
<td>2</td>
</tr>
<tr>
<td>C</td>
<td>axes LONG</td>
<td>2</td>
</tr>
<tr>
<td>D</td>
<td>timing pulleys</td>
<td>10</td>
</tr>
</tbody>
</table>

image 39: attaching the wooden caps in corner D

image 40: parts needed for this step
To help you performing the actions, the following overview is provided, see image 41.

To attach axis FRONT (SHORT) perform the following actions:

1. Get axis SHORT
2. Rotate the wooden end cap WITHOUT hole (RIGHT panel, FRONT), see image 42.
3. Put the pulleys on the timing belts. Use ONE timing pulleys for each timing belt.
   **NOTICE:** the thinnest side of the timing pulley is facing to the outside.
4. Move the axis SHORT from the RIGHT panel to the LEFT panel, see image 44.
   Place the following five parts, in order, on the axis SHORT:
   - timing belt with ONE timing pulley.
   - FRONT slider block.
   **NOTICE:** the clamp of the FRONT slider block is facing downwards along the FRONT panel, see image 43.
   - timing belt with ONE timing pulley.
5. Rotate the wooden end cap WITHOUT hole (RIGHT panel, FRONT) back to its normal position.
6. Attach the wooden end gap WITHOUT hole with a bolt M3 x 16mm and a hex nut 3mm.
Step 4: Mounting the axes  Assembling the X/Y axes

To attach the axis BACK (SHORT) perform the following actions:

1. Get a axis SHORT.
2. Rotate the wooden end cap WITHOUT hole (RIGHT panel, BACK).
3. Put the pulleys on the timing belts.
   Use ONE timing pulley for each timing belt which is connected to axis SHORT (FRONT panel).
   Use ONE timing pulley for the timing belt which is connected to the motor.

⚠️ NOTICE: the thinnest side of the timing pulley is facing to the outside.
4. Move the axis SHORT, from the RIGHT panel to the LEFT panel, see image 45.
   Place the following five parts, in order, on the axis SHORT:
   - timing belt which is connected to axis SHORT (FRONT panel) with ONE timing pulley.
   - BACK slider block.
   - timing belt which is connected to axis SHORT (FRONT panel) with ONE timing pulley.
   - timing belt which is connected to the motor with ONE timing pulley.
Step 4: Mounting the axes

Assembling the X/Y axes

1. **NOTICE:** the clamp of the BACK slider block is facing downwards along the BACK panel
   - timing belt which is connected to axis SHORT (FRONT panel) with ONE timing pulley.

5. Rotate the wooden end cap WITHOUT hole (RIGHT panel, BACK) back to its normal position.

6. Attach the wooden end cap WITHOUT hole with ONE bolt M3 x 16mm and ONE hex nut 3mm.

---

**Image 45:** attaching the BACK axis

To attach the Axis Left (LONG) perform the following actions:

1. Get an Axis (LONG).
2. Rotate the wooden end cap WITHOUT hole (BACK panel, LEFT).
3. Put the pulleys on the timing belts.
   - Use ONE timing pulley for each timing belt.

**NOTICE:** the thinnest side of the timing pulley is facing to the outside.

4. Move the axis LONG from the BACK panel to the FRONT panel, see image 46.
   - Place the following five parts, in order, on the axis:
     - timing belt with ONE timing pulleys.
     - LEFT slider block.

**NOTICE:** the clamp of the LEFT slider block is facing upwards along the LEFT panel.
Step 4: Mounting the axes

Assembling the X/Y axes

- timing belt with ONE timing pulleys.

5. Put the timing belt in the FRONT slider block, see image 47.
6. Put the timing belt in the BACK slider block, see image 48.
7. Rotate the wooden end cap WITHOUT hole (BACK panel, LEFT) back to its normal position.
8. Attach the wooden end cap WITHOUT hole with a bolt M3 x 16mm and a hex nut 3mm.

image 46: attaching the LEFT axis.

image 47: attaching the FRONT slider block on the timing belt

image 48: attaching the BACK slider block on the timing belt
To attach axis RIGHT (LONG) perform the following actions:

1. Get a axis LONG.
2. Rotate the wooden end cap WITHOUT hole (BACK panel, RIGHT).
3. Put the pulleys on the timing belts.
   Use ONE timing pulley for the timing belt which is connected to the motor.
   Use ONE timing pulley for each timing belt which is connected to axis LONG (LEFT panel).

⚠️ **NOTICE: the thinnest side of the timing pulley is facing to the outside.**
4. Move the axis LONG from the BACK panel to the FRONT panel, see image 49.
   Place the following five parts, in order, on the axis LONG:
   - timing belt which is connected to the motor with timing pulley.
   - timing belt which is connected to axis LONG with ONE timing pulley.
   - RIGHT slider block.

⚠️ **NOTICE: the clamp of the RIGHT slider block is facing upwards along the RIGHT panel.**
- timing belt which is connected to axis LONG (LEFT panel) with ONE timing pulley.
5. Rotate the wooden end cap WITHOUT hole (BACK panel, LEFT) back to its normal position.
6. Attach the wooden end ap WITHOUT hole with a bolt M3 x 16mm and a hex nut 3mm.

*image 49: attaching the RIGHT axis*
6.3

ASSEMBLING
THE EXTRUSION
HEAD

WHAT YOU’LL NEED
TO ASSEMBLE
THE EXTRUSION HEAD.

**Time:**
about 60 to 90 minutes

**Tools:**
hex keys (2mm)
hex keys (1,5mm)
pliers
small screwdriver (1,5mm)
6.3.1. **Step 1: Assemble the extrusion head housing**

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>spiral wrapping</td>
<td>1</td>
<td>N</td>
<td>cartridge heater</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>Thumb screw</td>
<td>4</td>
<td>O</td>
<td>thermocouple</td>
<td>1</td>
</tr>
<tr>
<td>C</td>
<td>brass pipe</td>
<td>1</td>
<td>P</td>
<td>wooden part FRONT, BACK, LEFT, RIGHT</td>
<td>4</td>
</tr>
<tr>
<td>D</td>
<td>teflon tube</td>
<td>1</td>
<td>Q</td>
<td>wooden part 8B</td>
<td>1</td>
</tr>
<tr>
<td>E</td>
<td>peek</td>
<td>1</td>
<td>R</td>
<td>aluminium plate</td>
<td>1</td>
</tr>
<tr>
<td>F</td>
<td>aluminium heater block</td>
<td>1</td>
<td>S</td>
<td>wooden part TOP</td>
<td>1</td>
</tr>
<tr>
<td>G</td>
<td>nozzle</td>
<td>1</td>
<td>T</td>
<td>blue horse shoe</td>
<td>1</td>
</tr>
<tr>
<td>H</td>
<td>linear bearing</td>
<td>1</td>
<td>U</td>
<td>WHITE bowden tube clamp</td>
<td>1</td>
</tr>
<tr>
<td>I</td>
<td>threaded spacers</td>
<td>2</td>
<td>V</td>
<td>black injection moulded part</td>
<td>1</td>
</tr>
<tr>
<td>J</td>
<td>hex nuts 3mm</td>
<td>6</td>
<td>W</td>
<td>strain relief plate</td>
<td>1</td>
</tr>
<tr>
<td>K</td>
<td>bolts M3 x 16mm</td>
<td>2</td>
<td>X</td>
<td>amplifier board</td>
<td>1</td>
</tr>
<tr>
<td>L</td>
<td>bolts M3 x 12mm</td>
<td>1</td>
<td>Y</td>
<td>acrylic mounting plate</td>
<td>1</td>
</tr>
<tr>
<td>M</td>
<td>bolts M3 x 10mm</td>
<td>7</td>
<td>Z</td>
<td>bowden tube</td>
<td>1</td>
</tr>
</tbody>
</table>
Step 1: Assemble the extrusion head housing

Assembling the extrusion head

image 50: parts needed for this step
To assemble the extrusion head housing, perform the following actions.

1. Attach the nozzle into the aluminium heater block, see image 51.
   \[\text{NOTICE: Attach the nozzle as tight as possible to the aluminium heater block.}\]
2. Attach the brass pipe into the aluminium heater block, see image 51.
   \[\text{NOTICE: A space between the brass pipe and the aluminium heater block is allowed, see image 52.}\]

\[\text{image 51: attaching the nozzle and brass pipe into the aluminium heater block.}\]

\[\text{image 52: result assembling the nozzle, brass pipe and aluminium heater block.}\]

3. Place the linear bearing in the FRONT and the BACK sides of the extrusion head housing, see image 53.
   \[\text{NOTICE: make sure the linear bearing is sicking IN but NOT sticking THROUGH the sides.}\]
4. Place ONE linear bearing in the RIGHT and the LEFT sides of the extrusion head housing, see image 53.
   \[\text{NOTICE: make sure the linear bearing is sicking IN but NOT sticking THROUGH the sides.}\]
4. Attach the sides together, see image 54.
   Use four bolts M3 x 10mm and four hex nuts 3mm.
5. Place the extrusion head housing into the wooden part 8B, see image 54.

6. Place the peek into the aluminium plate, see image 55.
   
   **NOTICE:** the aluminium plate is symmetric. You can choose any hole you want.

7. Attach the peek into the brass pipe (keep the aluminium heater block in position as shown), see image 55.

   **NOTICE:** Attach the peek through the aluminium plate to the brass pipe as tight as possible.
8. Attach the cartridge heater and the thermocouple through the wooden part 8B, see image 56.

NOTICE: use the hole back RIGHT.

NOTICE: the cartridge heater is the small 6 mm cylinder with a right angle.

NOTICE: the thermocouple is the small 3 mm cylinder with an aluminium sleeve.
9. Attach the thermocouple and cartridge heater in the back of the aluminium heater block, see image 57.
10. Lock the thermocouple and cartridge heater. Use ONE bolt M3 x 10mm.

11. Insert the teflon tube in the wooden part 8B, see image 58.
12. Attach the black injection moulded part on the wooden part marked TOP, see image 59.

*Notice*: pay attention to how the part is positioned.
Use ONE M3 x 12mm bolt and a hex nut.

13. Put two bolts M3 x 16mm through the bottom side of the wooden part marked TOP.
14. Place the acrylic mounting plate over the two bolts M3 x 16mm.
15. Place the amplifier circuit board over the bolts M3 x 16mm.
16. Attach two threaded spacers over the two bolts M3 x 16mm.
17. Place the strain relief plate on top of the threaded spacers.
18. Lock by screwing two bolts M3 x 10 mm into the threaded spacers.
19. Move the wires of the thermocouple, the cartridge heater and the small fan through the middle hole of the wooden part TOP, see image 61.

![Image 61: moving the wires of the thermocouple, cartridge heater and the small fan through the wooden part TOP](image)

(for action 20-22 see image 63)

20. Attach WHITE bowden tube clamp in the front RIGHT hole of black injection moulded part.

21. Move the Thumb screws through the corner holes.

22. Attach the Thumb screws. Do not attach the Thumb screws too tight.

![Image 62: Attaching the WHITE bowden tube clamp and the Thumb screws.](image)

**NOTICE:** keep a small gap between the wooden part and the aluminium plate.

23. Move the bowden tube through the WHITE bowden tube clamp and through the teflon tube.

**NOTICE:** use the end of the bowden tube which has no blue tape.
Tip: you can use a screwdriver to guide the bowden tube through the teflon tube.

24. Lock the bowden tube, by putting the blue horse shoe under the WHITE bowden tube clamp, see image 63.

**NOTICE:** give some light pressure on the bowden tube while placing the blue horse shoe.

25. Tighten the Thumb screws completely.

![image 63: attaching the blue horse shoe](image)

26. Place the RED wire of the thermocouple in the RIGHT socket and screw till the wire is clamped.
   Use a 2mm screwdriver.

27. Place the YELLOW wire of the thermocouple in the LEFT socket and screw till the wire is clamped, see image 64.

![image 64: attaching the thermocouple wires in the socket](image)
6.3.2 Step 2: cooling fan assembly

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Metal Fanduct (1501)</td>
<td>1</td>
<td>E</td>
<td>bolts M3 x 16mm (1204)</td>
<td>2</td>
</tr>
<tr>
<td>B</td>
<td>Bolt M3x4mm (1348)</td>
<td>2</td>
<td>F</td>
<td>Self Tapping Bolts (1362)</td>
<td>2</td>
</tr>
</tbody>
</table>

To assemble the cooling fan assembly, perform the following actions.

1. Take the Metal fanduct and place it around the heaterblock. See image 66.
2. Use the 2x M3x4mm bolts to lock it into place by screwing them into the aluminium plate of the hot end assembly. The fancap screws into the bottom of the hotend.
3. Position the fan correctly between the metal fancap and the hotend. with the sticker facing downwards.
4. Use the 2x M3x16mm bolts to screw it into the aluminum plate of the hotend assembly. See image 67.
5. Secure the fan to the metal fancap by using the 2 self tapping screws.
Step 2: Cooling fan Assembly

Assembling the extrusion head

see image 68

**image 66:** attaching the front of the fancap

**image 67:** attaching the back of the fancap and fan.

**image 68:** attaching the fan to the metal fanduct.
6.3.3. Step 3: attaching the housing on the XY frame

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>X and Y axes</td>
<td>2</td>
<td>D</td>
<td>wooden parts C</td>
<td>4</td>
</tr>
<tr>
<td>B</td>
<td>bolts M3 x 30mm</td>
<td>4</td>
<td>E</td>
<td>spacers</td>
<td>2</td>
</tr>
<tr>
<td>C</td>
<td>hex nuts 3mm</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To attach the housing on the XY frame, perform the following actions.

1. Place a wooden part C into the LEFT slider block, see image 70.
   - Notice: do not tighten yet.

2. Move X and Y axes in the extruder head, see image 71.
   - Notice: make sure the extruder head is placed inside the machine, below the slider blocks.
Notice: make sure the FRONT side of the extruder head is faced to the FRONT panel.

3. Move the X axis in the LEFT slider block, see image 72.
   Notice: make sure the Y axis do not fall out.
4. Move the Y axis in the FRONT and BACK slider blocks, see image 72.
5. Turn the RIGHT slider block.
6. Move the X axis in the RIGHT slider block.
   Notice: make sure the X and Y axis are placed in the right order in the slider blocks to prevent the X and Y axis from bending.
7. Move the wooden part C in FRONT, BACK and RIGHT slider blocks.
8. Attach ONE bolts M3 x 30mm in each FRONT, BACK and RIGHT slider blocks, see image 73.
   Notice: do not tight the bolts M3 x 30mm yet.
9. Attach the wooden parts C.
10. Tighten the bolts M3 x 30mm
    Notice: Do not force. Make sure the X and Y axis do not bend.
Step 3: attaching the housing on the XY frame

Assembling the extrusion head

To calibrate the XY-gantry perform the following steps:

11. Align the X axis of the extruder head.
    Use two spacers.

12. Tighten the timing pulleys which are attached to the LEFT timing belt, see image 74.

**NOTICE:** make sure the spacers use the same notch. Move the RIGHT sliderblock in the correct position if needed.

13. Tighten the timing pulleys which are attached to the RIGHT timing belt.

**NOTICE:** use another notch if the timing pulleys can not be reached.

14. Repeat step 13 and 14 for the Y axis, FRONT timing pulley and BACK timing pulley.
Step 3: attaching the housing on the XY frame

Assembling the extrusion head

15. Move the X motor down and keep it in position.
   **Notice:** push gently, do not overdo.

16. Tighten the bolts, see image 76

17. Repeat step 14 and 15 for the Y motor.

18. Move the extruder head all to the end of the X axis.
   **Notice:** Make sure you hear the limit switch clicking.
   If not: move the RED wired limit switch till the clicking sound occurs.

19. Tighten the RED wired limit switch.

20. Repeat step 19 and 20 for the BLUE wired limit switch.

---

**image 75:** adjusting the timing pulleys

**image 76:** tightening the bolts of the X motor
ASSEMBLING THE Z STAGE

WHAT YOU’LL NEED TO ASSEMBLE THE EXTRUSION HEAD.

**Time:**
about 60 to 90 minutes

**Tools:**
hex keys (2mm)
small screwdriver (1.5mm)
6.4.1. **Step 1: Assembling the drive nut assembly**

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>wooden parts</td>
<td>4</td>
<td>B</td>
<td>drive nut</td>
<td>1</td>
</tr>
</tbody>
</table>

To make the drive nut assembly, perform the following actions.

1. Place the two smaller wooden parts around the driver nut.
2. Place the bigger wooden parts, see image 78.

![Image 77: parts needed for this step](image77.png)

![Image 78: assembling the drive nut assembly](image78.png)
6.4.2. **Step 3: LEFT and RIGHT arm assembly**

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Qty.</th>
<th>Description</th>
<th>Letter</th>
<th>Qty.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>16</td>
<td>wooden panel</td>
<td>C</td>
<td>14</td>
<td>bolts M3 x 30mm</td>
</tr>
<tr>
<td>B</td>
<td>2</td>
<td>linear bearings</td>
<td>D</td>
<td>14</td>
<td>hex nuts 3mm</td>
</tr>
</tbody>
</table>

*LEFT arm*  

- A
  - b  
  - c  
  - d  
  - e  
  - f

*RIGHT arm*  

- A
  - b  
  - c  
  - d  
  - e  
  - f

- B  
  - 14 x

- C  
  - 2 x

- D  
  - 14 x

*image 79: parts needed for this step*
To assemble the LEFT arm, perform the following actions (for action 1-6 see image 80).

1. Move seven bolts M3 x 30mm through the wooden part marked LEFT B.
2. Place a linear bearing on top of the wooden part marked LEFT B.
3. Place the parts marked LEFT C and C on top of part LEFT B.
4. On top of that, place the parts marked LEFT D and D.
5. On top of that, place the parts marked LEFT E and E.
6. On top of that, place the parts marked LEFT F and F.
7. Attach the parts together.
   Use seven hex nuts 3mm.

Notice: it can take some force.

Notice: Make sure to bolt tight.

To assemble the RIGHT arm, perform the following actions.
(For action 7-12, see image 81)

1. Move seven bolts M3 x 30mm through the wooden part marked RIGHT B.
2. Place a linear bearing on top of the wooden part marked RIGHT B.
3. Place the parts marked RIGHT C and C on top of part RIGHT B.
4. On top of that, place the parts marked RIGHT D and D.
5. On top of that, place the parts marked RIGHT E and E.
6. On top of that, place the parts marked RIGHT F and F.
7. Attach the parts together.
   Use ONE hex nut 3mm.
   **Notice: it can take some force.**
   **Notice: Make sure to bolt tight.**

![Image of assembling the RIGHT arm](image81)

**6.4.3. Step 2: inserting the adjustable level screws**
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>wooden panel</td>
<td>1</td>
<td>E</td>
<td>hex nuts 3mm</td>
<td>8</td>
</tr>
<tr>
<td>B</td>
<td>bolts M3 x 30mm</td>
<td>4</td>
<td>F</td>
<td>springs</td>
<td>4</td>
</tr>
<tr>
<td>C</td>
<td>washers</td>
<td>4</td>
<td>G</td>
<td>delrins</td>
<td>4</td>
</tr>
<tr>
<td>D</td>
<td>bolts M3 x 10mm</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To insert the adjustable level screws, perform the following actions.

1. Place the delrins in each corner hole.
2. Attach the delrins.
   - Use two bolts M3 x 10mm and two hex nuts 3mm for each delrin.
3. Attach ONE spring and ONE washer together on each delrin.
   - Use ONE bolt M3 x 30mm.

**Notice:** do not bolt tight.
6.4.4. Step 4: finishing the Z stage assembly
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>LEFT arm</td>
<td>1</td>
<td>D</td>
<td>hex nuts 3mm</td>
<td>20</td>
</tr>
<tr>
<td>B</td>
<td>drive nut assembly</td>
<td>1</td>
<td>E</td>
<td>wooden panel with adjustable level screws</td>
<td>1</td>
</tr>
<tr>
<td>C</td>
<td>RIGHT arm</td>
<td>1</td>
<td>F</td>
<td>bolts M3 x 30mm</td>
<td>20</td>
</tr>
</tbody>
</table>

![Image 84: parts needed for this step]

To finish the Z stage assembly, perform the following actions (for action 1-3 see image 85).

1. Put six hex nuts 3mm in the slots of the drive nut assembly,
2. Move the drive nut assembly in the RIGHT arm.
3. Bolt the parts together.
   
   **Tip:** bolt crosswise.

   **Notice:** bolt tight.
Step 4: finishing the Z stage assembly

Assembling the Z stage

4. Place the six hex nuts 3mm in the slots of the wooden panel with adjustable level screws.
5. Move the parts into each other.
6. Attach the parts together.
   Use six bolts M3 x 30mm.

If done correctly, the result must look like this, see image 87.
6.4.5. **Step 5: Applying tape to the bed**
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>acrylic print platform</td>
<td>1</td>
<td>B</td>
<td>blue tape</td>
<td>1</td>
</tr>
</tbody>
</table>

![Image showing parts A and B](image88.png)

**image 88: parts needed for this step**

To prepare the bed for its first print, perform the following actions.
1. Remove the protection foil from both sides of the acrylic.
2. Put blue tape strokes on top of the surface, see image 89.
   - **Notice:** place the tape strokes next to each other, NOT over each other.
3. **Notice:** place the strokes in the same directions as shown in image 89.
4. Cut the blue tape by running a knife through the length of the groove that is engraved in the acrylic, see image 90.
5. Remove the excess part of the tape.
Step 5: Applying tape to the bed

5. Place the acrylic print platform on the wooden subassembly by sliding it over the adjustable level screws, see image 91.
### 6.4.6. Step 6: installing the Z stage in the machine

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>leadscrew M8</td>
<td>1</td>
<td>D</td>
<td>bolts M3 x 16mm</td>
<td>4</td>
</tr>
<tr>
<td>B</td>
<td>Z stage</td>
<td>1</td>
<td>E</td>
<td>wooden parts 3B</td>
<td>2</td>
</tr>
<tr>
<td>C</td>
<td>12mm axes</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Image 92: parts needed for this step](image)

To install the Z stage in the machine perform the following actions.

1. Place the Z stage in the machine.
2. Move 12mm axis through the TOP panel, and through the linear bearing of the Z stage, see image 93.
3. Move the 12mm axis further, through the BOTTOM panel, see image 93.
4. Do the same for the second 12mm axis, see image 93.
5. Attach wooden part 3B on top of the 12mm axes.
   Use two bolts M3 x 16mm for each wooden part 3B.
Step 6: installing the Z stage in the machine

Assembling the Z stage

6. Attach the leadscrew M8 through the drive nut, see image 94. Tip: grease the leadscrew with magnalube, see for more information paragraph 6.4.7.

7. Attach the two screws on the coupling with a hex key, see image 95.
The frame is now ready!

6.4.7. **Step 7: greas it up**
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>magnalube tube</td>
<td>1</td>
</tr>
</tbody>
</table>

To grease the leadscrew, perform the following actions.

1. Put a droplet of the supplied tube of grease on your finger (a volume comparable with a Sportlife gum).
2. Spread the droplet across the leadscrew (on straight line from top to down is fine).

**Notice:** the drive nut will spread the grease later, when the leadscrew rotates.
ASSEMBLING THE MATERIAL FEEDER

WHAT YOU’LL NEED TO ASSEMBLE THE MATERIAL FEEDER.

**Time:**
about 30 to 40 minutes.

**Tools:**
hex keys (2mm)
adjustable wrench (has to fit M8 nuts or pliers)
small screwdriver (2mm)
6.5.1. **Step 1: drive mechanism main body assembly**

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Qty.</th>
<th>Description</th>
<th>Letter</th>
<th>Qty.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td>wooden part 10A</td>
<td>F</td>
<td>1</td>
<td>stepper motor</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>wooden part 10B</td>
<td>G</td>
<td>2</td>
<td>hex nuts 3mm</td>
</tr>
<tr>
<td>C</td>
<td>2</td>
<td>wooden part 10C</td>
<td>H</td>
<td>6</td>
<td>bolts M3 x 20mm</td>
</tr>
<tr>
<td>D</td>
<td>1</td>
<td>quick fit coupling</td>
<td>I</td>
<td>2</td>
<td>ball bearings 8mm</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>small black gear</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To assemble the extrusion head housing, perform the following actions.

1. Move the small black gear over the motor axis, see image 97.

   **Notice:** make sure the small black gear is placed on the top motor axis, so the motor axis does not sticks out.

2. Place a ball bearing 8mm in the hole of the wooden part 10A.

3. Place a ball bearing 8mm in the hole of the wooden part 10C, see image 98.
4. Place wooden part 10A on top of the motor.

\textbf{Notice: make sure the engraving is facing the motor.}

5. Place the wooden part 10B on top of the wooden part 10A.
6. Place the quick fit coupling in the T-slot.
7. Place the wooden part 10C on top of the wooden part 10B.
8. Attach the wooden parts A, B and C on the motor.
   Use four bolts M3 x 20mm.
9. Place two bolts M3 x 20mm near the ball bearings 8mm and lock with two hex nuts 3mm.
6.5.2. **Step 2: drive bolt assembly**

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>wooden gear (engraved extrude)</td>
<td>1</td>
<td>D</td>
<td>washers M8</td>
<td>3</td>
</tr>
<tr>
<td>B</td>
<td>hobbed bolt</td>
<td>1</td>
<td>E</td>
<td>cap nut M8</td>
<td>1</td>
</tr>
<tr>
<td>C</td>
<td>hex nut M8</td>
<td>1</td>
<td>F</td>
<td>delrin clip</td>
<td>1</td>
</tr>
</tbody>
</table>

![Image 99: mounting different parts on the motor](image99)

![Image 100: parts needed for this step](image100)
To make the drive bolt assembly, perform the following actions. (for action 1-8 see image 101 and image 102)

1. Place the delrin clip on the groove of the hobbed bolt.
2. Move the hobbed bolt through the ball bearings 8mm.
   Notice: check if the ‘good’ gripping part of the drive bolt is positioned straight between the two wooden parts. If not, consider to attach the wooden parts of the drive mechanism main body a little more tight.
3. Place the hex nut M8 inside the wooden gear.
4. Place two washers M8 over the hobbed bolt.
5. Attach the wooden gear on the hobbed bolt
   Notice: Do not attach too tight. Check if the gear can rotate freely in the ball bearings 8mm.
6. Place a washer over the hobbed bolt, on top of the wooden gear.
7. Place the cap nut M8 loosely on the hobbed bolt.
8. Now carefully tighten the cap nut M8 and the wooden gear. Be sure the hobbed bolt is able to rotate in the ball bearings 8mm.
   Notice: do not force!
9. Check if the motor with the small black gear makes contact with the wooden gear. Adjust if necessary.
   Notice: make sure the small black gear and wooden gear are not under pressure.
   Notice: you can use the small hole in the wooden gear to adjust the motor if it is not alligned correctly

![Image 101: Assembling the drive bolt assembly (1)]
6.5.3. **Step 3: clamp assembly**
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>U-Bracket</td>
<td>1</td>
<td>B</td>
<td>bolts M3 x 20mm</td>
<td>3</td>
</tr>
<tr>
<td>B</td>
<td>black wheel</td>
<td>1</td>
<td>C</td>
<td>spring</td>
<td>1</td>
</tr>
<tr>
<td>C</td>
<td>mounting plate</td>
<td>1</td>
<td>D</td>
<td>hex nut 3mm</td>
<td>1</td>
</tr>
<tr>
<td>D</td>
<td>bolts M3 x 16mm</td>
<td>6</td>
<td>E</td>
<td>side plate B</td>
<td>1</td>
</tr>
<tr>
<td>E</td>
<td>washer</td>
<td>1</td>
<td>F</td>
<td>bolts M3 x 25mm</td>
<td>1</td>
</tr>
<tr>
<td>F</td>
<td>ball bearing 8mm</td>
<td>1</td>
<td>G</td>
<td>lock nuts</td>
<td>7</td>
</tr>
<tr>
<td>G</td>
<td>side plate A</td>
<td>1</td>
<td>H</td>
<td>Black Lever</td>
<td>1</td>
</tr>
</tbody>
</table>
To make the clamp assembly, perform the following actions.

1. Push the ball bearing 8mm in the black wheel, see image 104.
   Tip: use a piece of redundant wood to apply more force if needed.
2. Place a hex nut 3mm in the T-slot of the mounting plate, see image 105.

   (for action 3-5 see image 106)
3. Place the black wheel (with ball bearing 8mm) in the mounting plate.
4. Place two side parts over the mounting and attach the parts together.
   Use four bolts M3 x 16mm and four lock nuts.
   **NOTICE: mind the orientation.**
5. Place ONE bolt M3 x 20mm through the ball bearing 8mm and tighten loosely.
   Use ONE lock nut.
6. Place the U-Bracket on side of the clamp assembly, see image 107.
7. Attach a spring and a washer on the hole of the U-Bracket.
   Use a bolt M3 x 25mm.
Notice: because you have to push the spring, it can take some force.
Notice: the spring should stick out about 11mm.
Notice: If it is hard to reach. Try without the spring first.

The result must look like this, see image 108.

8. Attach the clamp assembly with U-Bracket on the main body of the drive mechanism.
   Use ONE bolt M3 x 20mm and ONE lock nut.
   Notice: do not screw too tight, the clamp assembly with U-Bracket must be able to move.
   Notice: make sure the lock nut is NOT placed on the side of the gear.

9. Connect the lever to the main body of the drive mechanism.
   Use ONE bolt M3 x 20mm and a ONE lock nut.
   Notice: do not screw too tight, it must be able to move.
   Notice: make sure the lock nut is NOT placed on the side of the gear.
Step 4: attaching the feeder to the machine

To attach the feeder to the machine, perform the following actions:

1. Attach the feeder in the slots of the BACK panel, see image 111
2. Place the bow shaped tube in the tube couple of the material feeder mechanism.
3. Secure the bow shaped tube with a blue horse shoe.
4. Move the wires from the material feeder through the hole below the material feeder of the BACK panel.
5. Move the wires through the corner hole of the BOTTOM panel.
6.5.5. Step 5: assemble the filament holder

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>wooden parts 11B</td>
<td>2</td>
<td>B</td>
<td>wooden parts 11C</td>
<td>4</td>
</tr>
</tbody>
</table>

To assemble the filament holder, perform the following actions.

1. Position two wooden parts 11B next to each other.
2. Push the four wooden parts 11C in the slots of the two wooden parts 11B, see image 113.
3. Place the filament holder in the slots in the BACK panel, see image 114.
6.6 MOUNTING THE ELECTRONICS CIRCUIT BOARD

WHAT YOU’LL NEED TO MOUNT THE ELECTRONICS CIRCUIT BOARD.

**Time:**
about 30 to 60 minutes.

**Tools:**
- hex keys (2mm)
- tiny flat screwdriver
What you need to know before you start attaching the electronics. The electronics simply need to be attached to the machine and a few wire connectors plugged in. For extra safety, there’s also a cooling system under the electronics that will reduce the chance of problems. The stepper drivers can get hot, and if they would overheat, a thermal fuse will turn them off. The cooling system will allow the machine to work in a warm environment or allow you to set the current slightly higher than usual.

Warning! When handling electronics make sure that you are not statically charged. This can permanently damage your electronics.

6.6.1.  Step 1: mounting the electronic circuit board
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>bolts M3 x 30mm</td>
<td>4</td>
<td>C</td>
<td>electronic circuit board</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>threaded spacers</td>
<td>4</td>
<td>D</td>
<td>tube spacers</td>
<td>4</td>
</tr>
</tbody>
</table>

![Diagram of the electronic circuit board]

*image 115: parts needed for this step*
To attach the electronic circuit board, perform the following actions.
(for action 1-4 see image 116)
1. On the BOTTOM panel put four bolts M3 x 30mm from INSIDE towards OUTSIDE.
2. Place the tube spacers over the four bolts M3 x 30mm.
3. Place the electronic circuit board over the bolts M3 x 30mm, on the tube spacers.
4. Secure with four threaded spacers.

6.6.2. Step 1: preparing the electronic cooling system
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>cooling fan</td>
<td>1</td>
<td>E</td>
<td>wooden electronic panel</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>cooling duct sheet</td>
<td>1</td>
<td>F</td>
<td>bolts M3 x 30mm</td>
<td>2</td>
</tr>
<tr>
<td>C</td>
<td>blue scotch tape</td>
<td>1</td>
<td>G</td>
<td>bolts M3 x 12mm</td>
<td>5</td>
</tr>
<tr>
<td>D</td>
<td>wooden cover panel</td>
<td>1</td>
<td>H</td>
<td>hex nuts 3mm</td>
<td>7</td>
</tr>
</tbody>
</table>

*image 116: mounting the electronics circuit board*
To prepare the electronic cooling system, perform the following actions.

1. Attach the fan to the side that is not marked, see image 118.
   Use two bolts M3 x 30mm and two hex nuts 3mm.
2. Fold the cooling duct sheet along the perforations, see image 119.
3. Place the cooling duct sheet over the wooden panel, see image 121.
4. Turn the assembly over (you will face the engraved side now).
5. Attach the wooden air-duct cover, see image 122.
   Use five bolts M3 x 12mm and five hex nuts 3mm.

Notice: make sure you fasten very tight (but do not force it).
Step 1: preparing the electronic cooling system

Mounting the electronics circuit board

image 118: mounting the fan

image 119: folding the cooling duct sheet sideview 1.

image 120: folding the cooling duct sheet side view 2.

image 121: placing the cooling duct sheet
6. Put blue tape on the hex nuts 3mm, see image 123.
   - **Notice:** you have to perform this action to isolate the bolts M3 x 12mm electrically.

7. Tape the tiny gaps around the cooling duct sheet.
   - **Notice:** you have to perform this action to prevent unwanted air leaks.

8. Connect the cooling fan to the (always on) 12V power output,
### 6.6.3. step 3: connecting the heater

To connect the heater, perform the following actions.

1. Connect the WHITE wires of the heater element to the terminals of the heater 1 output, see image 125.
   - Notice: do not strip the wires too much. This can cause short circuit.
   - Notice: do not strip the wires too short. This can cause no contact.
2. Attach the terminals.
   - Use a small screwdriver.
   - Notice: make sure the cable is secure.

![Connecting the heater](image124: connecting the heater)
6.6.4. **Step 4: connecting the print head electronics**
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Qty.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Black electronic cable with 3 tiny plugs on both sides</td>
<td>1</td>
</tr>
</tbody>
</table>

To connect the print head electronics, perform the following actions

1. From the bottom of the machine, guide the three tiny plugs through the RIGHT BACK corner of the machine.

   **Notice:** the side with the three smaller plugs should be connected to the print head.

2. Guide the three tiny cable plugs through the cable duct.
3. Plug the RED/BLACK fan connector of the extruder head in the BLUE/ PURPLE connector of the black cable.
4. Plug the RED/BLACK/YELLOW connector (with the dot) on the white connector of the extruder head (tiny circuit board), see image 126.

   **OPTIONAL:** when you make use of dual extrusion, plug the GREEN/ ORANGE/BROWN connector on the second connector.

5. Turn the machine on its side.
6. Plug in the BLUE/PURPLE plug in the connector called FAN PRINTHEAD on the circuit board.
7. Plug in the RED/BLACK/YELLOW plug in the connector called TEMP1 on the circuit board.
8. Plug in the GREEN/ORANGE/BROWN plug in the connector called TEMP2 on the circuit board.
6.6.5. **Step 5: connecting the limit switches**
To connect the limit switches, perform the following actions.

1. Connect the plug of BLACK wired limit switch 1 to the connector 1 on the circuit board.
   The BLACK wired limit switch 1 is situated behind a hole in the BOTTOM plane.
2. Connect the plug of BLACK wired limit switch 2 to the connector 2 on the circuit board.
   The BLACK wired limit switch 2 is situated at the TOP of the machine.
3. Connect the plug of RED wired limit switch 3 to the connector 3 on the circuit board.
   The RED wired limit switch 3 is situated at the BACK of the machine.
4. Connect the plug of RED wired limit switch 4 to the connector 4 on the circuit board.
   The RED wired limit switch 4 is situated at the FRONT of the machine.
5. Connect the plug of BLUE wired limit switch to the connector called FRONT RIGHT on the circuit board.
   This BLUE wired limit switch situated at the RIGHT of the machine.
6. Connect the plug of BLUE wired limit switch to the connector called FRONT LEFT on the circuit board.
   This BLUE wired limit switch situated at the LEFT of the machine.

6.6.6. **Step 5: connecting the motors**
To connect the motors, perform the following actions:

1. Connect the plug of X motor to the connector called X motor on the circuit board.
   The X motor is mounted on the BACK plane inside the machine.
2. Connect the plug of Y motor to the connector called Y motor on the circuit board.
   The Y motor is mounted on the LEFT panel inside the machine.
3. Connect the plug of Z motor to the connector called Z motor on the circuit board.
   The Z motor is mounted on BOTTOM panel under the machine.
4. Connect the plug of EXTRUDER-MOTOR to the connector called EXTRUDER-MOTOR on the circuit board.
   The EXTRUDER-MOTOR is mounted on the EXTRUDER outside the machine.

**Notice:** check the connections you have just made.
**Notice:** if you have the Ulticontroller, assemble it before going to the next paragraph. How to assemble the Ulticontroller is described in chapter 6.7.
6.6.7. Step 7: mounting the electronics cooling system
The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Qty</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>bolts M3 x 10mm</td>
</tr>
</tbody>
</table>

To mount the electronic cooling system, perform the following actions.
(for action 1-4 see image 127)
1. Attach the bolts M3 x 10mm into the white threaded spacers, but not all the way.
2. Place the cooling assembly over the bolts M3 x 10mm.
3. Move the cooling assembly.
The bolts M3 x 10mm must end in the smaller parts of the slots.
4. Attach the bolts M3 x 10mm slightly more, till they touch the wood.

![image 126: mounting the electronic cooling system](image_126)

6.6.8. Step 7: strain relief
To achieve strain reliefs, perform the following actions.
1. Guide the cables (black cable and the white cables connected to the extrusion) through the strain relief.
   Tip: the strain relief is the strain relief plate on top of the extrusion head.
2. Wrap the black cable, bow shaped tube, and the white cables (all connected with to the extrusion head) together in transparent wire wrapping. Goal is to get a tidy cable.
3. Wrap all cables together at the underside of the BOTTOM plate. Use the velcro strips.

6.6.9. Step 9: Checking and aligning the top-Z limit switch

Notice: this is the MOST important end-stop of the machine. It’s important that the starting height is about 0.1mm above the acrylic platform.

To check and align the top-Z limit switch, perform the following actions:
(for action 1-12 see image 128)
1. Turn the leadscrew until the extrusion head is almost touching the acrylic platform.
   Tip: it must be possible to move ONE A4 paper between the nozzle and the acrylic platform. TWO A4 papers must NOT be possible.
2. Move the extrusion head to the FRONT LEFT corner.
3. Screw OUT the FRONT LEFT adjustment bolt till the acrylic platform touches the nozzle.
4. Screw IN the FRONT RIGHT adjustment bolt.
5. Move the extrusion head from the FRONT LEFT to the FRONT RIGHT corner.
   This must be possible without making scratches. Otherwise, screw IN the FRONT RIGHT adjustment bolt a little more.
6. Screw OUT the FRONT RIGHT adjustment bolt till the acrylic platform touches the nozzle.
7. Screw IN the BACK RIGHT adjustment bolt.
8. Move the the extrusion head from the FRONT RIGHT to the BACK RIGHT corner.
9. Screw OUT the BACK RIGHT adjustment bolt till the acrylic platform touches the nozzle.
10. Screw IN the BACK LEFT adjustment bolt.
11. Move the the extrusion head from the BACK RIGHT to the BACK LEFT corner.
12. Screw OUT the BACK LEFT adjustment bolt till the acrylic platform touches the nozzle.
13. Loosen the bolts slightly of the top-Z limit switch. You must be able to move the switch up and down.
14. Turn the lead screw to elevate the acrylic platform until the nozzle of the extrusion head almost touches the platform.
15. Lower the limit switch.
16. Attach one side of the limit switch.
17. Move the other side.
   Notice: the limit switch will rotate a little.
18. Rotate the switch till you hear a click.
   The switch is now closed.
19. Attach the other side of the limit switch slightly.
   If you do not hear the click. Release the other bolt and lower the switch a little more till it clicks.
20. Attach the bolts tight.

Notice: the switch shouldn't move anymore.

Notice: when you are using the control software for the first time, test the response to the limit switches. Especially the top-Z limit switch.
ASSEMBLING AND CONNECTING THE ULTICONTROLLER

WHAT YOU’LL NEED TO ASSEMBLE AND CONNECT THE ULTICONTROLLER.

**Time:**
about 10 to 20 minutes.

**Tools:**
hex keys (2mm)
6.7.1. Step 1: assembling the Ulticontroller

The following parts are needed in this step.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Qty.</th>
<th>Description</th>
<th>Letter</th>
<th>Qty.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td>Ulticontroller BACK</td>
<td>F</td>
<td>1</td>
<td>Ulticontroller LEFT</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>display v1.0</td>
<td>G</td>
<td>1</td>
<td>Ulticontroller RIGHT</td>
</tr>
<tr>
<td>C</td>
<td>4</td>
<td>tube spacer</td>
<td>H</td>
<td>4</td>
<td>bolts M3 x 25mm</td>
</tr>
<tr>
<td>D</td>
<td>4</td>
<td>bolts M3 x 10mm</td>
<td>I</td>
<td>10</td>
<td>hex nuts 3mm</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>Ulticontroller FRONT</td>
<td>J</td>
<td>1</td>
<td>button</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>K</td>
<td>1</td>
<td>Ulticontroller PCB</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Connection Cable</td>
</tr>
</tbody>
</table>

To assemble the ulticontroller, perform the following actions.

1. Remove the foil from the display V1.0 (if present).
2. Remove the protective sticker from the piezo speaker (if present).
3. Attach the display v1.0 to the Ulticontroller FRONT, see image 130.

   Use four bolts M3 x 25mm, four tube spacers and four hex nuts 3mm.
Step 1: assembling the Ulticontroller

Assembling and connecting the Ulticontroller

4. Turn the controller on its front.
5. Plug both of the PCB connector cables into the connectors.
   plug cable 1 into connector 1, plug cable 2 into connector 2.
6. Place six hex nuts 3mm inside the slots of the Ulticontroller BACK.
   Tip: Use tape to keep the hex nuts 3mm in position.
7. Attach the Ulticontroller BACK onto the Ulticontroller FRONT,
   Use two bolts M3 x 10mm at the long sides.
8. Attach the side parts.
   Use two bolts M3 x 10mm for every side.
9. Put the button in place, see image 132.
6.7.2. **Step 2: connecting the controller**

To connect the Ulticontroller, perform the following actions.

1. Turn off the Ultimaker Original.
2. Disconnect the electronic cooling system.
3. Guide the cables through the hole in the BOTTOM panel.
4. Connect the cable.
5. Place back the Electronics cooling system.
6. Put the Ulticontroller on the lower part of the FRONT panel.
7. Turn the power on.
8. Insert the SD-card.

**Notice:** check for firmware updates and information the Software setup guide.

Congratulations! You are ready to print now.
7 Usage of the Ultimaker Original

7.1 USING THE ULTIMAKER ORIGINAL FOR THE FIRST TIME
We recommend you to use supplied software, but feel free to use different types of programs if you feel like you are up to it, or just simply disagree. Playful experimenting and innovating is what made Ultimaking B.V. to what it is today.

There are 2 different types of software that you will need to get your Ultimaker printing. Some software have these combined, others do not. First you need a slicer to create the file that contains all the parameters of a print, called the Gcode. Secondly you need software to send this Gcode to your Ultimaker. In the beginning you most likely will download a file from the world wide web to print. Plenty of these files can be found on websites like www.youmagine.com.

One of the files that is printable is called a STL.

### 7.1.1. Slicer software

As a slicer we can recommend you to use:
- Cura
- Slic3r
- Kisslicer
- Netfabb

The basic idea of slicing is that it converts a printable file (STL) to a code that contains all the information to create your print. We will take you along to create a Gcode, to print with PLA.

**Cura**

1. Go to our website menu ‘community’
2. ‘download’ for the latest version of Cura.
3. Open Cura
4. Go to Expert > Install default Marlin Firmware.
5. Use the default STL
6. Go to Tools > Switch to Quickprint.
7. Choose High Quality Print, and PLA.
8. If asked, enter the diameter of your filament.

   **Notice:** The filament should be approximately 2.85mm, but it may vary 0.7mm.

   **Notice:** If you do not have digital calipers, enter a number between 2.85-2.90mm.

   **Notice:** You do not have to tick ‘Print Support Structure’.

Is the Ultimaker Original connected with the computer, go to action 9. If it’s not. Go to action 10.
Via the computer
9. If the Ultimaker is connected with the computer, click ‘Print’.

Via the Ulticontroller
10. Save the file on your SD-card.
11. Insert the SD-card into the slot on the LEFT of the Ulticontroller.
   On the display v1.0, it should say, ‘Card inserted’.
12. Rotate the navigation wheel.
13. Select ‘Print’ or ‘Card menu’.
14. Select the file you want to print.

Netfabb
1. Download a STL, for example: http://www.thingiverse.com/thing:13588
2. Go to Project > Open and select the file you want to print.
3. Click the small cross next to ‘Parts’ (in top RIGHT corner), and drag the
   STL file to the Ultimaker tab. If you do this correctly the file will appear
   on a build platform interface.
4. If there are any issues with it then NetFabb will prompt you to
   automatically fix it... Do that.
5. Select either No raft, or Outline. Outline will put a box around the print
   and is good for getting your plastic flowing smoothly at the start. Any
   other raft is generally not necessary.
6. Under ‘Current Part’ click on ‘Center’ to put your object in the middle
   of the platform (or move it to where you’d like to print).
7. Select your print quality (that’s the build style) and under ‘extruder’
   select the machine settings profile. Make sure you’re profile match up
   for the standard profiles (i.e. if you use the Ultra profile in one then use
   the Ultra profile for the other... They’re designed to go together).
8. Set the fill spacing slider to something like 2.5-4mm to start with. If
   you cannot move the slider (it’s greyed out) then make sure your part
   is selected on the bed by clicking on it.
9. Hit ‘Calculate toolpath’... That will do the slicing.
Directly via the computer

1. When the Ultimaker is connected with the computer just hit print to print it.
3. Scroll down to the bottom of the page and click Windows > Precompiled version.
5. Connect your Ultimaker via an USB port and chose the RIGHT port from the list.
6. It is most likely tty.usb.something. Feel free to try several ports if you can not find it, nothing bad can come from this.
7. Set baudrate to:
   - 57600 if you are running the default firmware (5D).
   - 250000 if you are running Sprinter or Marlin firmware.
8. Click connect. If your printer doesn’t connect, chose a different usb port. Make sure you have turned on your Ultimaker.
9. Go to File > Open and select the Gcode you want to print.
10. Preheat the nozzle of the Ultimaker to 180°C.
11. Click ‘Print’.

Via the Ulticontroller

1. To print it with the Ulticontroller, save your gcode to SD card for example.
2. Place the SD card into the SD slot on the LEFT of your Ulticontroller.
3. On the screen it should say, Card inserted.
4. Press the navigation wheel, go to card menu and select the file you want to print.
5. Your Ultimaker will go ‘home’ heat up to the RIGHT temperature and calculate a path and start to print.
Ultimaker
The fast, easy to use, Open-source 3D printer